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Oh don’t the days seem lank and long

When all goes right and nothing goes wrong,

And isn’t your life extremely flat

With nothing whatever to grumble at!

W.S. Gilbert and Arthur Sullivan, Princess Ida
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The Purpose

The purpose of this booklet is to help you gain control over the tabs and
indents on your Macintosh. These little rascals seem to confuse most people,
but once you learn how to control them, oh, your life is so much easier and
happier and your documents look so much better. As with most things in
life, the answers in this book will make more sense to you if you have had
the problems first; that is, if you have not yet struggled with making tabs
and indents work, you might not find this book so exciting.

The reason I can put together a little book covering the concept of tabs and
indents on the Mac regardless of the particular application is because tabs and
indents work the same in just about every application that uses them (except
WordPerfect, which is very different from other Mac applications).

This book consists of some general information about tabs and indents, and
then a series of exercises for you to use on your own Mac, using the text files
on the enclosed disk. There are written step-by-step directions for word
processing with Microsoft Word, Microsoft Works, MacWrite II, ClarisWorks, and
WriteNow, and for page layout with PageMaker and Quark. At the back of the
book are some advanced tips and tricks in each of these applications.

I suggest you read through the first section, “Things you should know,” before
you begin, then do some of the exercises, then read the first section again when
you get confused, then exercise a little more, then read it again. Then when you
start to get it, teach tabs and indents to someone else.
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Things You Should Know

There are a few things you should know and understand about tabs and indents
before you start working with them. You see, tabs and indents always do what
you tell them! If you have trouble with tabs and indents, it is only because you
don’t know what you’re telling them!  Don’t scream at those poor tabs—they are
trying to do what you want. It’s your responsibility to figure out how to tell them
what to do. They always work. They are extremely dependable and reliable and
logical (yes, logical). And they work exactly the same in every program on the
Mac, so once you get the concept in one application, you can apply it to any other
application.

Remember how difficult it was for you to learn to put one space after periods
instead of two?  Well, there are also a few things you need to relearn about tabs
and indents, contrary to what you may have learned on your typewriter.

1. The ruler is where the tab and indent information is set and
displayed, and every paragraph has its own ruler settings.
This is critical. Any tab or indent settings you set in the ruler will apply only
to the paragraph that is currently selected! Ruler settings are “paragraph-
specific,” meaning all formatting in the ruler applies to the entire paragraph.
Paragraph-specific formatting includes alignment (centered, flush left, etc.),
any extra space between paragraphs that you may choose to apply, and style
sheets, if you use them.

Any formatting you apply in a ruler or any specifications you choose
in a “Paragraph” dialog box will apply  only to the selected paragraph,
and it will apply to the  entire paragraph.

Try this experiment in a word processor: Type several short paragraphs. Click
in the first paragraph and move the markers around in the ruler and perhaps
change the alignment. Now click in the second paragraph and notice the
ruler settings!
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2. There are two key things to remember about all paragraphs:

You create a new paragraph on the Mac every time you press the
Return or Enter keys. A return address three lines long is actually three
paragraphs. So if you want to apply the same ruler settings to the entire
address, you must select all three lines/paragraphs.

A paragraph is selected when the insertion point is flashing within it,
or when any number of characters is highlighted. You do not have to
highlight the entire paragraph to apply new ruler settings to it.

3. Tabs are cumulative, and they accumulate in the word you type
after you hit the Tab key.
Huh? If you hit the Tab key three times and then type the word “Jimmy,” that
word Jimmy holds onto those three tabs. Jimmy will jump over to the third
tab he can find (which does not necessarily mean the third tab in the ruler).
If you then hit two more tabs and type the word “Ryan,” the word Ryan holds
onto five  tabs—the tabs accumulate! And again, Ryan will jump to the fifth
tab he can find. I say “the fifth tab he can find” because perhaps Jimmy’s
name is too long and extends past the fourth tab in the ruler; then Ryan
doesn’t count that tab—he only counts two more beyond Jimmy.

▼

Each of these tiny markers
indicates a default tab
(see #4, opposite). You
can see that Jimmy is
sitting on the third tab.

▼

Ryan has been told to go to the fifth tab
(see the actual tab characters in #5, next
page). If you count the tiny default tab
markers, though, you see he couldn’t
reach the one that Jimmy’s name covered,
so went to the fifth one he could find.
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4. Every ruler has default (automatically created for you) tab settings,
usually every half inch. As soon as you set your own tab, every
default tab to the left of that new tab disappears!
So let’s say in the example above that you just started hitting those tabs, using
the defaults. Jimmy ended up at the 1.5-inch mark, right? With a tab every
half inch, three tabs puts him at 1.5 inches. If you now click in the ruler to
set a tab at 2 inches, Jimmy will jump to the 3-inch mark!  Darn. Why’d he
do that? He did that because you told him to go to the third tab he can find.
As soon as you set your own tab at 2 inches, the defaults to the left of that
new tab disappeared. That makes the 2-inch tab the first one; the default tab
still existing at 2.5 inches is the second, and Jimmy is going to the default
tab at 3 inches.

▼

When you click in the ruler,
you set a new tab. This tab

causes all the default tabs to
the left of it to disappear.

▼

But Jimmy still does what he’s told—
you hit three tabs before you typed his
name, so he is dutifully sitting right
on the third tab.

WriteNow does not have default tabs every half inch, but a new document does have three
tabs set into position. Setting new tabs will not remove the existing tabs in WriteNow; you
have to remove them manually.
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5. You can remove extra tabs in text just as if they were characters.
One reason why tabs can be so confusing is because the tabs that have
accumulated are invisible. In most programs you can choose to display them
(see opposite page), in which case tab characters appear as little arrows.

Even when you cannot see the actual tab characters, you can remove them
just as if they were letters. If you had typed three letter T’s in front of the word
“Jimmy,” how would you delete those three T’s? Right—you would either
press-and-drag to select those three characters and delete them, or you
would use the insertion point to backspace over them.

Here you can clearly see the three tab
characters that Jimmy is obeying, and you
can see that Ryan has accumulated five tabs.

Tabs accumulate throughout the entire paragraph! If you delete one of
Jimmy’s tabs, then Ryan no longer goes to the fifth tab—he finds the fourth
tab; take a close look at the last example.

You can press-and-drag over the tab space to select
and delete it.

Or you can just click your insertion point right in front
of the word and backspace once for each tab.

Notice that when you delete one of Jimmy’s tabs,
you also delete one of Ryan’s.
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Sometimes you may want to see those tab characters. When you show the
tab characters, you will also see the paragraph markers, dots in each space, and
line breaks (sometimes called soft Returns, if the program features them, created
by typing a combination such as Shift Return, instead of a regular, “hard” Return).
These characters that you can type but not see are called “non-printing” or
“invisible” characters or sometimes “paragraph symbols” or “hidden symbols.”
Not  all programs can show them to you, but this is how to do it in several of
the most popular applications:

Microsoft Word: From the View menu, choose “Show ¶,”
or press Command J.

MacWrite II: From the View menu, choose “Show Invisibles,”
or press Command ;  (semicolon).

WriteNow: From the View menu, choose “Show Invisibles,”
or press Command ;  (semicolon).

Microsoft Works: Cannot display non-printing characters.

ClarisWorks 2.0: From the Edit menu, choose “Preferences…”;
click “Show Invisibles.”

PageMaker: You can only see the markers while in the Story Editor
(with the text tool, click in the story you want to check,
then press Command E). From the Options menu, choose
“Display ¶.” You can also use the Preferences dialog box
to set the default to display the characters.

QuarkXPress: From the View menu, choose “Show Invisibles,”
or press Command I.

To turn off the symbols, simply repeat the same command.
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6. The indent is not the margin.
You do not set your margins in the ruler; you set your margins in another
dialog box. You already know how to set your margins, I’ll bet, because
you’ve been doing it already. In PageMaker or Quark you set margins in the
first dialog box that appears for a new publication; in Word, set them in the
Document dialog box from the Format menu; in MacWrite and ClarisWorks,
the Page dialog box from the Format menu; in WriteNow, the Page Setup
dialog box from the File menu.

This is a typical example of margin specs.

In most applications*, the ruler starts at 0 (zero; shown below) and there
is an indent marker at zero. This zero does not mean that the text will
start typing on the edge of the paper! It means the indent  will be
indented zero inches from wherever your margin is, the margin you set for
the page or document (also see #7). For instance, if you set the margins in
the Page Setup at 1 inch left and right, and then set an indent (the triangular
markers in the ruler) at the half-inch mark, the text would actually start 1.5
inches from the left edge of the paper—one inch as the margin, plus one-
half inch as the indent.

This indent marker (the
triangle) on the right is also

automatically set on the
margin (the margin is

indicated by the dotted line.)

Right now, there is no indent
specified at all; the indent marker
(the triangles, in this case), are
aligned at zero, which is the left
edge of the  margin.

▼ ▼



15

␣*ClarisWorks, MacWrite, and WriteNow show the entire ruler from 0 to
8.5 inches, and the indent markers are not on zero, but on the actual
measurement for the margin.

In every application, the indent marker is always

automatically positioned directly on the existing

margin (in word processing) or text box/block (in

page layout).

☞

The Claris ruler

If you work in PageMaker or QuarkXPress, see the important note on
page 20 about their rulers in relation to the document.
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7. The text word wraps between the indents. Always. There is a left
indent, a right indent, and a first-line indent.
There is an indent marker on the left of the ruler and one on the right (usually
they are triangles; shown in the illustration on the previous page at 0 and
4 inches). The text starts at the left indent and as you type it moves over to
the right. When the text bumps into the right indent marker (not the
margin), it bounces back to the left indent marker.

Text always bounces back and forth between the indent markers,
not between the margins!

The left marker breaks into two pieces, one for the first line of a
paragraph and one for the rest of the paragraph. This is the coolest thing.
Sometimes you want to indent a paragraph a couple of spaces, right? Well,
instead of setting a tab and then hitting the tab key for the first line of every
paragraph, you simply move the first-line indent marker over.

So, what really happens and what has been happening to you all
this time is this: When you hit a Return, the insertion point jumps to
wherever the first-line indent marker is (see the examples on the opposite
page). The text flows along until it bumps into the right indent marker,  then
it bounces back to wherever the left indent marker  is. Until you hit another
Return, the text bounces back and forth between the left and right indent
markers. When you hit a Return, the insertion point jumps to the first-line
indent marker.
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In this ruler, the triangle on the left splits into two parts. No matter what your
left marker looks like, it splits into two parts. Here the two parts are in the

▼

same position, so the first line of
each paragraph, plus the rest of
the paragraph all bounce back to
the same place. Notice the right
edge of the text aligns with the
right indent marker.

You can create a hanging indent by moving the left indent (bottom
portion of the triangle) inward. Notice how the text starts at the first-line

indent and bounces between the
left and right indents.

Here the two parts of the left marker have been separated. The top portion
of the triangle is the first-line indent marker. When I hit a Return, the

text begins at that marker. It
moves to the right, bumps into the
right indent marker, then bounces
back to the left indent marker,
which is actually just the bottom
half of that triangle.

▼

▼



18

Tab and Indent Markers

No matter which program you are using, you have at least four tabs: left, right,
center, and decimal. Different applications display different icons for each one.

Tabs always give you a visual clue as to their function. A left-aligned tab has a
straight edge along the left  side (where the text will align) and a little tail or
triangle pointing to the right, in the direction the type will extend. Right-aligned
tabs do the opposite, of course, and centered tabs have either no tail, or triangles
pointing in both directions. Decimal tabs have a little dot.

When you hit the Tab key to a left-aligned
tab, the insertion point goes to the tab
marker and the text types to the right
(it aligns on the left).

When you hit the Tab key to a  right-
aligned tab, the insertion point goes to
the tab marker and the text types to the
left (it aligns on the right).

When you hit the Tab key to a centered
tab, the insertion point goes to the tab
marker and the text types out to both
sides of the tab. Cool.

When you hit the Tab key to a  decimal tab,
the insertion point goes to the tab marker.
The text extends to the left until you type a
decimal (a period), then the text continues
on the other side, typing to the right. Really
cool. Some programs accept other charac-
ters in the decimal place, not just periods.

To move a tab: Press-and-drag it to a new position.

To delete a tab: Press-and-drag the tab marker up or

down out of the ruler, then just let go.

To change a tab: Delete the existing tab marker and

replace it with a new tab marker.

(In PageMaker you can change a tab by selecting
the tab marker [click once on it], and then clicking
on another tab alignment button to change it.)
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No matter which program you are using, you have a left indent, right indent,
and first-line indent. The marker on the left always breaks into two parts (as
explained on page 17). The illustrations below are examples of rulers from
various applications, along with their tab markers, that show the left marker
separated into the first-line indent marker and the left indent marker.

All tab buttons shown are in this order: left, center, right, decimal.

Microsoft Word: Click the tab button
to select the type of tab, then click in the
ruler to set it. You can also set tabs by
typing a ruler position in the Tabs dialog
box: From the Format menu, choose
“Paragraph…” (or press Command M),
then click the “Tabs…” button. Or just
double-click in the ruler to get the same
Tabs dialog box.

Microsoft Works 3: Select a tab icon,
then click in the ruler. Note: Each time
you click on the tab marker in the ruler,
the tab changes to a different kind of tab!
This is useful and quick, but be careful—
watch those tails. Microsoft Works 2
uses a whole triangle for the left indent,
and a tiny square dot for the first-line
indent; they are often hard to separate.

T/Maker WriteNow: Press on a tab
button and drag it into the ruler. The
four tab buttons you see here are in
the standard order: left, center, right,
decimal. These tab and indent markers
look different from the markers you will
see in the examples throughout this
book. Please don’t be confused!

Claris MacWrite II or Claris Works:
Press on a tab button and drag it into the
ruler. The four tab buttons you see here
are in the standard order: left, center,
right, decimal. These tab and indent
markers look different from the markers
you will see in the examples throughout
this book. Please don’t be confused.

right indent

left indent; hold the Shift key to
move the marker independently

first-line indent

right indentleft indent

first-line indent

right indentfirst-line indent

left indent; hold the Shift key
to move the left indent
independently

left indent; hold
the Option key
to move the left
indent marker
independently

These tiny marks
indicate the
default tabstab buttons

tab buttons

tab buttons

first-line indent

tab buttons right
indent
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QuarkXPress: You can use the
Formats ruler (from the Style menu)
to set indents, but you can only set
left-aligned tabs in this ruler. I find it
more efficient to use the Tabs ruler
(also from the Style menu) because
I can set both tabs and indents
there. In the dialog box, choose a
tab alignment from the mini-menu,
then click in the ruler or  type a ruler
measurement into the Position box.

Aldus PageMaker: Click on a tab
button to choose the sort of tab you
want, then click in the ruler. You
can also position tabs by typing a
ruler measurement into the Position
edit box, then use the Position
mini-menu to move it.

left indent

first-line indent right indent

tab buttons

left indent; hold Shift key
to move independently

right indentfirst-line indent

Important note for both PageMaker and Quark: The tabs/indents ruler has
nothing to do with the ruler for the document! Don’t draw guide lines from the
document ruler and tell yourself you want a tab at 2 inches, then try to set a tab
in the tabs/indents ruler at 2 inches, because the tabs/indents ruler applies only
to the text that has been selected (with the text tool in PageMaker; with the
Content tool in Quark). The tabs/indents ruler always aligns with the left edge
of the text block (in PageMaker) or the text box (in Quark, minus the text inset),
and always only stretches as far as the text block/box. Even if your text is in such
a position on the screen that the tabs/indents ruler cannot align with it, the zero
marker in the ruler still indicates the left edge of the text block or text box.
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The Exercises

You read the first part, right, about things you should know and understand
about tabs and indents? Even if that didn’t make perfect sense yet, continue on
with these exercises. Then go back and read that information again—each time
a little more of it will make sense.

Each of these exercises uses a file on the enclosed disk. There are files for each
of the applications I use by name in this booklet, plus there is a folder of “text-
only” exercises that any other word processor should be able to open. You may
need to open your word processor first and then open the text files from within
the application.

WriteNow: At the beginning of each exercise, after  you select the text, you need
to actually click in the ruler (or  press Command R) before you can use the ruler.
I want to remind you again that WriteNow does not use default tab stops like
most other applications on the Mac. There are three “default” tabs that are really
just regular tabs already placed for you. Contrary to regular implementation,
these “default” tabs do not disappear when you set your own tabs.

PageMaker:  “Place” the Microsoft Word files as usual. Set up your document
with one-inch margins all around to get the closest approximation to what I have.

QuarkXPress: Before you “Get Text” (Microsoft Word files), set up a text box
about five inches wide and five inches deep, one column.

Don’t worry if the text on your screen doesn’t look exactly like the text in the
book (as long as it has the same words). The fonts may be different, the line
breaks may be different, and words may not align just as they do on these pages.
That’s okay.

Do the following exercises twice each

The first time, follow the paint-by-number directions. Then repeat the same
exercise, this time not  using the text provided, but using something of your own.
At the end of this booklet is a “final exam” to prove to yourself whether you
really get it or not, plus a few more tips on setting up your own text with tabs
and indents.

☞
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Exercise 1: Left and right indents
Open, place, or get Exercise 1. It should look something like this:

Using the directions on the right, reformat the middle paragraph so it is
indented on both sides. Remember, to select a paragraph, you only need
to click in it.

O u r   r e v e l s   n o w   a r e   e n d e d .
These our actors, as I foretold you, were all spirits, and are melted into
air, into thin air; and like the baseless fabric of this vision, the cloud-
capp’d towers, the gorgeous palaces, the solemn temples, the great globe
itself, yea, all which it inherit, shall dissolve and, like this insubstantial
pageant faded, leave not a rack behind.

We are such stuff as dreams are made on,
and our little life is rounded with a sleep.

O u r   r e v e l s   n o w   a r e   e n d e d .
These our actors, as I foretold you, were all spirits,
and are melted into air, into thin air; and like the
baseless fabric of this vision, the cloud-capp’d
towers, the gorgeous palaces, the solemn temples,
the great globe itself, yea, all which it inherit, shall
dissolve and, like this insubstantial pageant faded,
leave not a rack behind.

We are such stuff as dreams are made on,
and our little life is rounded with a sleep.
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Word and Microsoft Works

❏ Click anywhere in the middle paragraph.

❏ On the left edge of the ruler, press on the bottom half of that triangle
and drag it to the right 1.5 inches (both parts of the triangle should
move together).

❏ On the right side of that same ruler, find the other black triangle—
drag it 1.5 inches to the left.

MacWrite II, ClarisWorks, WriteNow

❏ Click anywhere in the middle paragraph.

❏ On the left edge of the ruler, press on the triangle and drag it to the
right 1.5 inches (the other little marker should come along too).

❏ On the right side of that same ruler, find the other black triangle—
drag it 1.5 inches to the left.

PageMaker

❏ With the text tool, click anywhere in the middle paragraph.

❏ From the Type menu choose “Indents/tabs…” or press Command␣I.

❏ On the left edge of the ruler, press on the bottom half of that triangle
and drag it to the right .75 inches (both halves of the triangle will and
should come with you).

❏ Find the triangle on the right of the ruler; you may need to scroll to
find it. Press on the triangle and drag it .75 inches inward, to the left.

❏ Click the Apply button if you like, then click OK.

QuarkXPress

❏ With the Content tool, click anywhere in the middle paragraph.

❏ From the Style menu choose “Formats…” or press Command␣Shift F.

❏ On the left edge of the ruler, press on the bottom half of that triangle
and drag it to the right .75 inches (both halves of the triangle will and
should come with you).

❏ Find the triangle on the right of the ruler; you may need to scroll to
find it. Press on the triangle and drag it .75 inches inward, to the left.

❏ Click the Apply button if you like, then click OK.

You can, of course, always use this Paragraph Formats dialog box
to type in a number for the indents. In this case, you would type “.75”
in the “Left Indent” and “Right Indent” edit boxes.
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Exercise 2: Left indent
Open, place, or get Exercise 2. It should look something like this:

Reformat this text as shown, using the left indent. Actually, you want
to make sure you move the left indent marker and the first-line indent
marker together; if the two parts separate, drag them back together
and try again.

The quality of mercy is not strain’d; it droppeth as the gentle rain from heaven
upon the place beneath. It is twice bless’d; it blesseth him that gives and him that
takes.
Tis mightiest in the mightiest: it becomes the throned monarch better than his
crown; his sceptre shows the force of temporal power, the attribute to awe and
majesty, wherein doth sit the dread and fear of kings.
But mercy is above this sceptred sway—it is enthroned in the heart of kings; it is
an attribute to God herself, and earthly power doth then show likest God’s when
mercy seasons justice.

Shakespeare • The Merchant of Venice

The quality of mercy is not strain’d; it droppeth as the gentle rain from
heaven upon the place beneath. It is twice bless’d; it blesseth him that gives
and him that takes.

Tis mightiest in the mightiest: it becomes the throned monarch
better than his crown; his sceptre shows the force of temporal
power, the attribute to awe and majesty, wherein doth sit the dread
and fear of kings.

But mercy is above this sceptred sway—it is enthroned in
the heart of kings; it is an attribute to God herself, and
earthly power doth then show likest God’s when mercy
seasons justice.

Shakespeare • The Merchant of Venice

This is the ruler for the second paragraph.



25

Word and Microsoft Works

❏ Select all (press Command A) and indent the text on the right.
You know how to do this now, yes? Just drag the triangle in so the
text is about 4 inches wide.

❏ Click anywhere in the second paragraph (“Tis mightiest…”).

❏ In the ruler, find the little black triangle on the left margin; press on
the bottom half of that triangle and drag it to the .5-inch mark.

❏ Click anywhere in the third paragraph (“But mercy…”). Drag the left
marker to the 1-inch mark.

❏ Click anywhere in the last line and indent it to the 1.5-inch mark.

MacWrite II, ClarisWorks, WriteNow

❏ Select all (press Command A) and indent the text on the right.
Just drag the triangle in so the text is about 4 inches wide.

❏ Click anywhere in the second paragraph (“Tis mightiest…”).

❏ On the left margin, press on the triangle and drag it to the 1.75-inch
mark (both little markers should move together).

❏ Click anywhere in the third paragraph (“But mercy…”). Drag the left
markers to the 2.25-inch mark.

❏ Click anywhere in the last line and indent it to the 2.75-inch mark.

PageMaker

❏ With the pointer tool, resize the text block so it’s about 4 inches wide.

❏ With the text tool, click in the second paragraph (“Tis mightiest…”).

❏ From the Type menu choose “Indents/tabs…” or press Command␣I.

❏ In the tab/indent ruler, press on the bottom half of the triangle on the
left margin and drag it to the .5 inch mark; click OK.

❏ Repeat the process with the third paragraph and with the last line,
indenting them each one-half inch further.

QuarkXPress

❏ With the Content tool, click in the second paragraph (“Tis mightiest…”).

❏ From the Style menu choose “Formats…” or press Command␣Shift F.

❏ In the ruler, press on the bottom half of the triangle on the left
margin and drag it to the .5 inch mark; click OK.

❏ Repeat the process with the third paragraph and with the last line,
indenting them each one-half inch further.

Or you can enter numeric values for the indents in the “Left Indent”
edit box.

Trick question: How many paragraphs are in the text on the left? There are five—that “blank”
line is considered a paragraph because it contains a hard return.
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Reformat this text as shown, using the first-line indent. Experiment with
setting more text in this format: click your insertion point after the last
word (after “not”), hit a Return, and continue typing. Type several para-
graphs to make sure the first-line indent concept sinks in.

Will fortune never come with both hands full, but write
her fair words still in foulest letters?

She either gives a stomach, and no food—such are the
poor, in health;

Or else a feast, and takes away the stomach, such are the
rich, that have abundance and enjoy it not.

King Henry IV

Will fortune never come with both
hands full, but write her fair words still
in foulest letters?

She either gives a stomach, and
no food—such are the poor, in health;

Or else a feast, and takes away
the stomach, such are the rich, that have
abundance and enjoy it not.

King Henry IV

Exercise 3: First-line indent
Open, place, or get Exercise 3. It should look something like this:
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Word and Microsoft Works

❏ Select all (press Command A).

❏ Bring in the right indent so the text is about 3.25 inches wide, as
shown to the left, below.

❏ Find the little black triangle on the left margin. Press on the top half
of that triangle and drag it to the .5-inch mark. The top half of the
triangle is the first line-indent marker.

MacWrite II, ClarisWorks, WriteNow

❏ Select all (press Command A).

❏ Bring in the right indent so the text is about 3.25 inches wide, as
shown to the left, below.

❏ Find the little black triangle on the left margin. Don’t press on the
triangle—press on the little marker that is hiding under the triangle
and drag this other marker to the .5-inch mark. That’s the first-line
indent marker; see pages 17 and 19.

PageMaker

❏ Resize the text block: with the pointer tool, click once on the text;
press-and-drag the bottom right handle in and down so the text block
is about 3.25 inches wide, as shown.

❏ With the text tool, select the entire text block (click anywhere in the
text and press Command A).

❏ From the Type menu choose “Indents/tabs…,” or press Command␣I.

❏ In the tab/indent ruler, press on the top half of the triangle on the left
edge of the ruler and drag it to the .5-inch mark (the top half of the
triangle is the first-line indent marker). Click OK.

QuarkXPress

❏ With the Content tool, click anywhere in the text. Press Command A
to select all.

❏ From the Style menu choose “Formats…” or press Command␣Shift F.

❏ In the ruler, press on the top half of the triangle on the left margin
and drag it to the half-inch mark. Or  you can type .5 into the “First
Line” edit box. Click OK.

❏ Bring the right indent marker in to 3.5 inches.
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Exercise 4: Hanging indents
Open, place, or get Exercise 4. It should look something like this:

My tongue will tell the anger of my heart, or else my heart
concealing it will break.

And rather than it shall, I will be free even to the utter-
most, as I please, in words.

Think you a little din can daunt mine ears?

And do you tell me of a woman’s tongue that gives not
half so great a blow to hear as will a chestnut in a
farmer’s fire?
Petruchio & Katharina in The Taming of the Shrew

Reformat this text as shown, using the first-line indent, but this time
move the first-line marker to the left side of the left indent. This creates
a “hanging indent,” or “outdent.” Notice carefully how the text follows
the markers.

My tongue will tell the anger of my heart, or else
my heart concealing it will break.

And rather than it shall, I will be free even to the
uttermost, as I please, in words.

Think you a little din can daunt mine ears?

And do you tell me of a woman’s tongue that
gives not half so great a blow to hear as
will a chestnut in a farmer’s fire?

Petruchio & Katharina in The Taming of the Shrew
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Word and Microsoft Works

❏ Select all (Command A).

❏ Indent the text on the right to 4 inches (you know how to do that now).

❏ Hold the Shift key down and drag the bottom half of the triangle (the
left indent marker) to the 1⁄2 inch mark; all the text except the first lines
will align at that position.

MacWrite II, ClarisWorks, WriteNow

❏ Select all (press Command A).

❏ Indent the text on the right to 4 inches (you know how to do that now).

❏ MacWrite and ClarisWorks: Hold the Option key down and drag
the triangle (the left indent marker) to the right 1⁄2 inch (the first-line
indent marker should be left behind). All the text except the first lines
will align at the left indent markers.

❏ WriteNow: You can’t drag the left indent separately from the first-line
indent, so you must drag both markers over 1⁄4 inch. Then drag the
first-line indent  back to the margin guide (leave the triangle at 1⁄2).

PageMaker

❏ Resize the text block: Click on the text with the pointer tool; press-
and-drag the bottom right handle in and down so the text block is
about 4 inches wide, as shown to the left.

❏ With the text tool, select the entire text block (click anywhere in the
text and press Command A).

❏ From the Type menu choose “Indents/tabs…,” or press Command␣I.

❏ On the left margin, hold the Shift key down and press on the bottom
half of the triangle; drag the marker to the half-inch mark. Click OK.

QuarkXPress

❏ With the Content tool, click anywhere in the text. Press Command A
to select all.

❏ From the Style menu choose “Formats…,” or press Command␣Shift F.

❏ In the ruler, drag the left triangles to the half-inch mark, then press
on the top half of the triangle (the first-line indent) and drag it back
to zero. Pull the right triangle marker in about an inch.

Or: In the Paragraph Formats dialog box, type .5 into the Left Indent
edit box, which will indent the main body of text.

Type –.5 into the First Line edit box, which will send the
first-line indent back to zero (the first-line indent is always
relative to the left indent).

Type 1 into the Right Indent box. Click OK.
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Exercise 5: All indents
Open, place, or get Exercise 5. It should look something like this:

My mistress’ eyes are nothing like the sun; coral is far more red than her lips’ red.
If snow be white, why then her breasts are dun. If hairs be wires, black wires
grow on her head.

I have seen roses damasked, red and white, but no such roses see I in her cheeks.
And in some perfumes is there more delight than in the breath that from my
mistress reeks.

I love to hear her speak, yet well I know that music hath a far more pleasing
sound. I grant I never saw a goddess go—my mistress, when she walks, treads on
the ground.

And yet, by heaven, I think my love as rare as any she belied with false compare.

William Shakespeare
Sonnet 130

Now, you would never really make your text look like this, but I want you
to experiment with the indents. Do one paragraph at a time, and try to
predict, before you let go of the mouse or click OK, what the paragraph
will do. Don’t let it be a surprise—be in control. If you are still a little
confused, skip this one! Come back next week and try it again.

My mistress’ eyes are nothing like the sun;
coral is far more red than her lips’
red. If snow be white, why then her
breasts are dun. If hairs be wires,
black wires grow on her head.

I have seen roses
damasked, red and white, but no such roses
see I in her cheeks. And in some perfumes
is there more delight than in the breath that
from my mistress reeks.

I love to hear her speak, yet well
I know that music hath a far more
pleasing sound. I grant I never saw
a goddess go—my mistress, when
she walks, treads on the ground.

And yet, by heaven, I think my love as rare
as any she belied with false compare.

William Shakespeare
Sonnet 130 This is my favorite sonnet.
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Word and Microsoft Works

❏ Select all and indent this entire piece from the right to 2.5 inches.

❏ Click anywhere in the first paragraph. Hold down the Shift key and
drag the left indent marker  (the bottom portion of the triangle) to the
right, to the .5-inch mark.

❏ Click anywhere in the second paragraph. Drag the first-line indent
marker (the top portion of the triangle) to the right, to the 1-inch mark.

❏ Click anywhere in the third paragraph. Drag the left indent marker
(which will drag both portions of the triangle) to the right, to the
.5-inch mark.

MacWrite II, ClarisWorks, WriteNow

❏ Select all and indent this entire piece from the right to 2.5 inches wide.

❏ Click anywhere in the first paragraph. Hold down the Option key and
drag the left indent marker  (the triangle) to the right one-half inch.(In
WriteNow, you must drag both markers over a half-inch, then drag
the first-line indent back to zero).

❏ Click anywhere in the second paragraph. Drag the first-line indent
marker (the little marker under the triangle) to the right 1 inch.

❏ Click anywhere in the third paragraph. Drag the left indent marker
(which will drag both portions of the indent) to the right one-half inch.

PageMaker

❏ Resize the text block to 2.5 inches wide.

❏ You need to set each paragraph separately. With the text tool, click
anywhere in the paragraph, then press Command I to get the ruler.

❏ First paragraph: hold down the Shift key and drag the left indent marker
(the bottom portion of the triangle) to the right .5 inch. Click OK.

❏ Second paragraph: drag the first-line indent marker (the top portion
of the triangle) to the 1-inch mark. Click OK.

❏ Third paragraph: drag the left indent marker (which will drag both
portions of the triangle) to the .5-inch mark. Click OK.

QuarkXPress (these directions use the ruler; of course you can use the dialog box instead)

❏ Resize the text box to 2.5 inches wide.

❏ You need to set each paragraph separately. With the Content tool, click
anywhere in the paragraph; press Command Shift F to get the ruler.

❏ First paragraph: drag the left indent marker to the right .5 inch, then
drag the top portion of the triangle back to zero. Click OK.

❏ Second paragraph: drag the first-line indent marker  (the top portion
of the triangle) to the 1-inch mark. Click OK.

❏ Third paragraph: drag the left indent marker (which will drag both
portions of the triangle) to the .5-inch mark. Click OK.
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Exercise 6: Left-aligned tabs
Open, place, or get Exercise 6. It should look something like this:

When I typed this, I hit the Tab key
before each number. The text went to
the default tabs. I didn’t care if they
lined up at this point because I knew
that when I inserted my own tabs,
each number would line up at its
accumulated tab. I hit a tab before
“For” so it would also line up at the
first tab; I hit a tab before “Against”
so it would line up at the second tab.

You might want to display your
invisible characters (see page 13) so
you can clearly see where I typed a
tab character. Right now, in this
example, the numbers and the text
are aligning at the closest default tab
they can find. I don’t care where
they are right now! I know they
will align at their respective tabs as
soon as I replace the defaults with
the ones I set myself!

ForForForForFor AgainstAgainstAgainstAgainstAgainstEscalusEscalusEscalusEscalusEscalus 99 24ParisParisParisParisParis 18 26MontagueMontagueMontagueMontagueMontague 98 46NurseNurseNurseNurseNurse 77 67JulietJulietJulietJulietJuliet 32 12TybaltTybaltTybaltTybaltTybalt 51 93RomeoRomeoRomeoRomeoRomeo 94 50
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Word and Microsoft Works

❏ Select all (Command A).

❏ Click on the left-aligned tab button to select it: . Then click in the
ruler at the 1.75 mark and again at the 2.75 mark; you should see
little arrows with tails appear in the ruler.

❏ If a tab is in the wrong place, simply press-and-drag it to another
position.

MacWrite II, ClarisWorks, WriteNow

❏ Select all (Command A).

❏ Press on the left-aligned tab button (WriteNow: ; MacWrite and
Claris Works: ) and drag it to the ruler; let go at the 3-inch
mark. Drag another left-aligned tab to the 4-inch mark.

❏ If a tab is in the wrong place, simply press-and-drag it to another
position.

PageMaker

❏ With the text tool, click anywhere in the text. Select all (Command
A). Press Command I to get the ruler.

❏ Click on the left-aligned tab button to select it: . Then click in the
ruler at the 1.75 mark and again at the 2.75 mark; you should see
little arrows with tails appear in the ruler.

❏ If a tab is in the wrong place, simply press-and-drag it to another
position. Or  you can select the tab marker by clicking once on it,
type in a new Position number, then use the Position menu to
“Move tab.”

QuarkXPress

❏ With the Content tool, click anywhere in the text. Select all (press
Command A). Press Command Shift T to get the ruler and the
Paragraph Tabs dialog box.

❏ In the Alignment menu inside the Paragraph Tabs dialog box, the
left-aligned tab is already chosen (it’s the default). So you can either
click in the ruler at the 1.75 mark, or  you can type 1.75 into the
“Position” edit box, and then click the Apply button.

Before you click OK, set another left-aligned tab at the 2.75 mark.

❏ If a tab is in the wrong place, simply press-and-drag it to another
position.



34

Exercise 7: Right-aligned tabs
Open, place, or get Exercise 7. It should look something like this:

Number of actors per scene

Scene: i ii iii iv v vi

Act I 25 16 33 16 27 —
Act II 10 21 15 35 29 18
Act III 30 28 11 19 13 —
Act IV 16 14 26 18 15 —

Numbers without decimal points are always aligned on the right. Although
the first column (“Scene” and the “Acts”) looks like it is indented with the
indent markers, it isn’t. I typed a tab before each line so I could align that
first column on the right also. You might want to display your invisible
characters to see the tabs.

Number of actors per scene

Scene: i ii iii iv v vi

Act I 25 16 33 16 27 —
Act II 10 21 15 35 29 18

Act III 30 28 11 19 13 —
Act IV 16 14 26 18 15 —

The first line (the headline: “Number of actors per scene”)
is centered. Never center a line that has tabs on it!
Tabs depend on a flush-left alignment.
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Word and Microsoft Works

❏ Center the first line*.

❏ Select the entire text block, except the first line**.

❏ Choose a right-aligned tab: .

❏ Click in the ruler at .75 inch; also at the 1.25 mark; and at 1.75, 2.25,
2.75, 3.25, and 3.75.

MacWrite II, ClarisWorks, WriteNow

❏ Center the first line*.

❏ Select the entire text block, except the first line**.

❏ Press on the right-aligned tab button (MacWrite, ClarisWorks: ;
WriteNow: ).

❏ MacWrite, ClarisWorks: Drag the tab to the ruler and set it at 2 inches;
let go. Also drag tabs to the 3-inch mark and to 3.5, 4, 4.5, 5, and 5.5.

WriteNow: There are tabs already in this text, but they are left-aligned.
Remove them one at a time and replace them with right-aligned tabs.

PageMaker

❏ With the text tool, select the entire text block, except  the first line
(why not the first line? what do you need to do to that first line?).

❏ Press Command I to get the tab/indent ruler.

❏ Choose a right-aligned tab by clicking on the right-aligned tab button,
the one with the tail pointing to the left: .

❏ Click in the ruler at .75; click again at 1.25. While the tab at 1.25 is
selected, press on the arrow in the “Position” edit box and choose
“Repeat.” PageMaker will repeat that half-inch tab (the distance
between the selected tab and the one to its left) across to the right.

QuarkXPress

❏ With the Content tool, select the entire text block, except  the first line
(why not the first line? what do you need to do to that first line?).

❏ Press Command Shift T to get the tab ruler and dialog box.

❏ From the Alignment menu within the Tabs dialog box, choose a
right-aligned tab.

❏ Click in the ruler at .75; click again at 1.25, 1.75, 2.25, 2.75, 3.25,
and 3.75. Or  you can type those numbers into the Position edit box,
clicking the Apply button after each.

␣* Center align the paragraph—this does not mean set a centered tab! Click once in the paragraph
and then choose “Centered” from your menu, or if you see an alignment icon, click it.

Choosing a centered alignment centers the text between the right and left indents—not between
the margins! So your text may not look centered, depending on where your indents are.

␣␣* * To select everything except the first line, click directly before “Scene” on the second line. Hold the
Shift key down, then click after the last character in the text.
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PERCENT OF STAGE TIME

ON OFF

CHARACTER STAGE STAGE

Oberon 8.15 91.85
Hamlet 100 0
Caliban .9 99.1
Othello 60 40
Cleopatra 27.07 72.93
Lear 51.5 48.5

Exercise 8: Decimal & centered tabs
Open, place, or get Exercise 8. It should look something like this:

PERCENT OF STAGE TIME

ON OFF

CHARACTER STAGE STAGE

Oberon 8.15 91.85
Hamlet100 0
Caliban .9 99.1
Othello 60 40
Cleopatra 27.07 72.93
Lear 51.5 48.5

You don’t need to change the title at all: A centered alignment (not a
centered tab) always centers the text between the left and right
indent, not between the margins.

Now, don’t get confused here. First set the tabs for the actors (set “Oberon”
through “Lear”). That’s just like Exercises 6 and 7. Then select the first two
lines of the heading (“On/Off” through “Stage”) and set their indent and tabs.
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Word and Microsoft Works

❏ Select the entire text, except the first line.

❏ Bring the left indent in (both triangles) to 1 inch.

❏ Click once on the decimal tab button .

❏ Click in the ruler at 2 3⁄8 inches; click also at the 3.25 mark.

❏ Your text should like the table shown, except ON STAGE and OFF

STAGE—these two lines (two paragraphs) have had the decimal tab
changed to a centered tab. Simply select those two lines, delete the
decimal tabs, and replace them with centered tabs ( ).

MacWrite II, ClarisWorks, WriteNow

❏ Select the entire text, except the first line.

❏ Bring the left indent in (both markers) to 1 inch.

❏ Press on the decimal tab button (MacWrite, ClarisWorks: ;
WriteNow: ) and drag the tab to the ruler; position it at 35⁄8 inches
and let go. Also drag a tab to the 4.5-inch mark.

❏ Your text should like the table shown, except ON STAGE and OFF STAGE—
these two lines (two paragraphs) have had the decimal tab changed to
a centered tab. Simply select those two lines, delete the decimal tabs
(just drag them off the bottom of the ruler), and replace them with
centered tabs (MacWrite, ClarisWorks: ; WriteNow: ).

PageMaker

❏ With the text tool, select the entire text block, except the first line.
Press Command I to get the tab/indent ruler.

❏ Bring the left indent in (both triangles) to 1 inch.

❏ Click on the decimal tab icon: , then click in the ruler at 2 3⁄8
inches; click also at the 3.25 mark. Click OK.

❏ Your text should like the table shown, except ON STAGE and OFF STAGE—
change the decimal tabs to centered tabs. Select those two lines and
get the ruler. Click on the decimal tab marker in the ruler, then click
on the centered tab button to change it. Also change the other one.

QuarkXPress

❏ With the Content tool, select the entire text block, except the first line.
Press Command Shift T to get the tabs ruler and dialog box.

❏ Bring the left indent in (both triangles) to 1 inch.

❏ From the Alignment menu, choose the decimal tab, then click in the
ruler at 2 3⁄8 inches; click also at the 3.25 mark. Click OK.

❏ Your text should like the table shown, except ON STAGE and OFF STAGE—
change the decimal tabs to centered tabs. Select those two lines and
get the ruler. Delete the decimal tabs (just drag them off the bottom
of the ruler), and replace them with centered tabs.
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Exercise 9: Tabs with leaders
Open, place, or get Exercise 9. It should look something like this:

Table of Contents

The Merry Wives of Windsor 3
King Lear 21
Hamlet47
Much Ado About Nothing 68
A Midsummer Night’s Dream 93
A Winter’s Tale122
The Phoenix and the Turtle 156

“Leaders” are the dots or lines that lead your eye from one column to
another. When working with leaders, remember that the tab marker
holds onto the leader specifications, so if you delete that tab, you delete
the leaders.

Practice these: click directly after the last number, hit a Return, type
some text, type a Tab, type a number, and continue.

Check the chapter on Suggestions and also the chapter on Tips and Tricks
at the end of this book for some interesting things to do with tab leaders
in some of the applications.

Table of Contents

The Merry Wives of Windsor ....................................................................3
King Lear ................................................................................................21
Hamlet ....................................................................................................47
Much Ado About Nothing .......................................................................68
A Midsummer Night’s Dream.................................................................93
A Winter’s Tale .....................................................................................122
The Phoenix and the Turtle ..................................................................156
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Word  (Microsoft Works cannot create tabs with leaders)

❏ Select the entire text, except the first line.

❏ Click the right-aligned tab button, then click in the ruler toward the
right margin to set a right-aligned tab marker.

❏ Double-click on the tab marker you just set.

❏ Under “Leader,” click in the “. . . .” button. Click OK.

MacWrite II, WriteNow (ClarisWorks cannot create tabs with leaders)

❏ Select the entire text, except the first line.

❏ Press on the right-aligned tab button (MacWrite: ; WriteNow: )
and drag the tab to the ruler; position it toward the right margin.

❏ MacWrite: Double-click on the tab marker you just set. In the dialog
box, type a period in the edit box “Fill Character.” Click OK.

❏ WriteNow cannot apply leaders to already-existing tabs; they can
only be created as you type. After you position the tab marker in the
ruler, select the space between the text and the number (for in-
stance, between “Windsor” and “3”). Press the Tab key, but before
you let go of the Tab key, type a period.

 ◆ Both: You can actually use any character you like before a Tab, and you
can select those leaders on the page and change their font and size.

PageMaker

❏ With the text tool, select the entire text block, except the first line.
Press Command I to get the tab/indent ruler.

❏ If you don’t see the black triangle margin marker on the right, then
press on that little scroll arrow to scroll the ruler until you do see it.

❏ Choose a right-aligned tab by clicking on the right-aligned tab button.

❏ Click in the ruler to create a tab about a half-inch before the right
margin, then press on that tab and drag it close to the right margin.

❏ While that tab is highlighted, choose a leader for it by pressing on the
arrow under “Leader”; or type in one or two of your own characters
to use as a leader. Click OK.

QuarkXPress

❏ With the Content tool, select the entire text block, except the first
line. Press Command Shift T to get the tab ruler and dialog box.

❏ If you don’t see the right margin, click to create a tab marker, then
drag that marker to the right. Delete the tab after you get there.

❏ From the Alignment menu, choose the right-aligned tab, then click in
the ruler near the right edge (or type a number in the “Position” box).

❏ In the “Fill” edit box, type a period. Click OK.
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Exercise 10: Right and left tabs
Open, place, or get Exercise 10. It should look something like this:

Memo
To: Antipholus
From: Dromio
Subject: The kitchen wench
Date: May 1, 1594

Marry, sir, she’s the kitchen wench and all grease; and I know not what use
to put her to but to make a lamp of her and run from her by her own light!
Help!

This is a simple little exercise in a practical situation.

Memo
To: Antipholus

From: Dromio
Subject: The kitchen wench

Date: May 1, 1594

Marry, sir, she’s the kitchen wench and all grease; and I know
not what use to put her to but to make a lamp of her and run from
her by her own light!
Help!
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All applications

You know by now, how to select the text and set a tab in the ruler, right?

❏ Select from Memo through the date 1594.

❏ Set a right-aligned tab about 3⁄4-inch from the left indent.

❏ Set a left-aligned tab about 7⁄ 8-inch from the left indent.
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Exercise 11: More hanging indents
Open, place, or get Exercise 11. It should look something like this:

Claudio[to Hero] Lady, as you are mine, I am yours; I give away myself
for you and dote upon the exchange.

Beatrice Speak, cousin, or, if you cannot, stop his mouth with a kiss,
and let not him speak neither.

Don Pedro In faith, lady, you have a merry heart.

Beatrice Yea, my lord, I thank it, poor fool, it keeps on the windy
side of care.

Claudio [to Hero] Lady, as you are mine, I am yours;
I give away myself for you and dote upon the
exchange.

Beatrice Speak, cousin, or, if you cannot, stop his mouth
with a kiss, and let not him speak neither.

Don Pedro In faith, lady, you have a merry heart.

Beatrice Yea, my lord, I thank it, poor fool, it keeps on the
windy side of care.

This is an important format to learn. Whether the first item in the para-
graph is a word or a bullet (•) or a number or a graphic, the arrangment
is the same. It’s so easy to arrange if you just remember that when you
hit a Return, the text bounces back to the first-line indent marker
(the top half of the triangle, in this ruler). As you type, the text bumps
into the right indent marker and bounces back to the left indent
marker (the bottom half of the triangle). Now, you do have to hit a tab
to get the first word in the main body of the paragraph over to the left
indent. Some applications need to have a tab marker sitting directly on
top of the left indent marker (as in this ruler). Most applications will use
the left indent marker as the first tab.

Experiment with this. After you have formatted the ruler, click an
insertion point at the end of the last paragraph. Hit a return, type a
name, hit the Tab key, type some text and watch it wrap into position.

☞
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Word and Microsoft Works

❏ Select all (press Command A).

❏ Bring the right margin in to 4 inches.

❏ In the ruler, find the little black triangles on the left margin. Hold the
Shift key down and press on the bottom half of that triangle; drag the
marker almost to the 1-inch mark.

MacWrite II, ClarisWorks, WriteNow

❏ Select all (press Command A).

❏ In the ruler, find the little markers on the left margin. Hold the Option
key down and press on the triangle; drag the marker to the 2-inch
mark. (WriteNow: you will have to drag both markers to the 2-inch
mark, then drag the first-line indent marker back to the margin guide.)

❏ Bring the right margin in to 5 inches.

PageMaker

❏ Resize the text block to about 4 inches wide, as shown, or  select the
text, get the ruler, and bring the right indent in to 4 inches.

❏ With the text tool, select the entire text block. Press Command␣I
to get the ruler.

❏ Hold the Shift key down and drag the bottom half of the triangle
almost to the 1-inch mark.

❏ Make sure the left-aligned tab button is highlighted, then click
directly beneath the left indent marker that you just set. Let go and
the tab marker will slide up and align itself on the left indent marker.
If not, move the tab so it is directly on top of the triangle, as shown
in the ruler on the opposite page. Click OK.

QuarkXPress

❏ Resize the text box to about 4 inches wide, as shown.

❏ With the Content tool, select the entire text block (press Command
A). Press Command Shift F to get the Paragraph Formats dialog box.

❏ Drag the left triangles almost to the 1-inch mark, then drag the top
half of the triangles back to zero. Or type 1 into the “Left Indent”
edit box, and type –1 into the “First Line” indent box. Click OK.
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Exercise 12: Numbered indent
Open, place, or get Exercise 12. It should look something like this:

All the world’s a stage, and all the men and women merely players: They have
their exits and their entrances; and one man in his time plays many parts, his acts
being seven ages:
1. At first the infant, mewling and puking in the nurse’s arms.
2. And then the whining schoolboy, with his satchel, and shining morning
face, creeping like snail unwillingly to school.
3. And then the lover, sighing like furnace, with a woeful ballad made to his
mistress’ eyebrow.
4. Then a soldier, full of strange oaths, and bearded like the pard, jealous in
honor, sudden and quick in quarrel.

This is a repetition of Exercise 11, just because it is so important. See if
you can figure it out before reading the directions. The first paragraph
has no special formatting, except I pulled the right indent in a little.
I used a left indent to indent the numbers themselves.

All the world’s a stage, and all the men and women merely players:
They have their exits and their entrances; and one man in his time plays
many parts, his acts being seven ages:

1. At first the infant, mewling and puking in the nurse’s arms.
2. And then the whining schoolboy, with his satchel, and shining

morning face, creeping like snail unwillingly to school.
3. And then the lover, sighing like furnace, with a woeful ballad

made to his mistress’ eyebrow.
4. Then a soldier, full of strange oaths, and bearded like the pard,

jealous in honor, sudden and quick in quarrel.

Don’t peek at this unless you must—it’s the ruler setting for the numbered paragraphs.
Your word processor will not require a tab directly on the indent.
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Word and Microsoft Works

❏ Select the paragraphs numbered 1 through 4.

❏ Press on the bottom portion of the triangle and drag it almost to the
half-inch mark (both parts of the triangle will move).*

❏ Press on the top portion of the triangle and drag it backwards about
a quarter-inch.

❏ Indent all the paragraphs from the right to 4 inches.

MacWrite II, ClarisWorks, WriteNow

❏ Select the paragraphs numbered 1 through 4.

❏ Press on the triangle and drag it almost to the 1.75-inch mark (both
parts of the marker will move).*

❏ Press on the little marker under the triangle and drag it backwards
about a quarter-inch.

❏ Indent all the paragraphs from the right to 5 inches.

PageMaker

❏ Resize the text block to 4 inches wide; or select all, get the ruler,
and bring the right margin marker in to 4 inches.

❏ With the text tool, select the paragraphs numbered 1 through 4;
press Command␣I to get the ruler.

❏ Press on the bottom portion of the triangle and drag it almost to the
half-inch mark (both parts of the triangle will move).*

❏ Press on the top portion of the triangle and drag it backwards about
a quarter-inch.

❏ Set a left-aligned tab directly on the bottom triangle, as in Exercise 11,
and as shown in the ruler on the opposite page.

QuarkXPress

❏ Resize the text box to about 4 inches wide, as shown, or get the ruler
and bring the right indent in.

❏ With the Content tool, select the paragraphs numbered 1 through 4;
press Command Shift F to get the Paragraph Formats dialog box.

❏ Drag the left triangles to the half-inch mark,* then drag the top half
of the triangles back to the quarter-inch mark.

Or type .5 into the “Left Indent” edit box, and type  –.25 into the
“First Line” indent box. Click OK.

␣* This is one way of moving the two separate markers into position —grab both, then move one
back. You could move them one at a time, but to move the left-indent marker separate from the
first-line indent marker, you must hold down the Option key or the Shift key (depending on the
application; WriteNow can’t do it at all) while you move it.
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Exercise 13: Indents over 9
Open, place, or get Exercise 13. It should look something like this:

Double, double toil and trouble; fire burn, and cauldron bubble:
1. Fillet of a fenny snake, in the cauldron boil and bake.
2. Eye of newt and toe of frog.
3. Wool of bat and tongue of dog.
4. Adder’s fork and blind-worm’s sting.
5. Lizard’s leg and owlet’s wing.
6. Scale of dragon, tooth of wolf.
7. Witches’ mummy.
8. Maw and gulf of the ravenous salt-sea shark.
9. Root of hemlock digg’d in the dark.
10. Nose of Turk and Tartar’s lips.
11. Finger of birth-strangled babe, ditch-delivered by a drab.
12. Cool it with a baboon’s blood.
Then the charm is firm and good, for a charm of powerful trouble, like a hell-broth
boil and bubble.

Double, double toil and trouble; fire burn, and cauldron bubble:
1. Fillet of a fenny snake, in the cauldron boil

and bake.
2. Eye of newt and toe of frog.
3. Wool of bat and tongue of dog.
4. Adder’s fork and blind-worm’s sting.
5. Lizard’s leg and owlet’s wing.
6. Scale of dragon, tooth of wolf.
7. Witches’ mummy.
8. Maw and gulf of the ravenous salt-sea shark.
9. Root of hemlock digg’d in the dark.

10. Nose of Turk and Tartar’s lips.
11. Finger of birth-strangled babe, ditch-delivered

by a drab.
12. Cool it with a baboon’s blood.

Then the charm is firm and good, for a charm of powerful trouble,
like a hell-broth boil and bubble.

Serious problem in the above example—see what happens when you get
to number 10? It is really tacky when the periods after the number (or the
parentheses, if used) don’t align. The trick is that you must type a tab
before the numbers, and set a decimal tab for those periods. If you did
not type a tab along the way, as in the above text, you must go back and
insert one in front of each number. Eventually you will figure out that
you should always type that tab first when numbering paragraphs.

This is what a numbered list should look like:
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This is what you must do to align those numbers. You must set a tab, either a
decimal tab or a right-aligned tab, for the numbers themselves (➊); leave enough
space to the left  of that tab to fit the highest number you will type. (In PageMaker
you must also set a tab for the first word of the text [➋], but every other application
mentioned in this booklet will use the left indent as a tab.) The first-line indent
is all the way to the left (➌), and the left indent is set where you want the text
to align (➍) as it word wraps.

❑ When you type, you have to remember (you’ll forget most of the time) to type
a tab before you type the number. Typing the first tab sends the insertion point
to the decimal tab, then the numbers type out to the left.

❑ After you type the number, hit the Tab key again so the insertion point moves
over to the next tab marker, which is directly on top of the left indent. Type
your paragraph. The text will bump into the right indent (➎) and bounce back
to the left indent (➍), remember?

❑ When you are ready for the next number, hit a Return, which will send the
insertion point all the way back to the zero point (or to wherever you set it).

❑ Continue following that sequence: Tab/type number/Tab/type text/Return;
Tab/type number/Tab/type text/Return, etc.

❑ If you want to type a second paragraph without a number, just follow
the same sequence but don’t type the number;  that is, just hit two tabs after
the Return. The insertion point will land at the second tab, which is where the
text begins.

So before you start the step-by-step directions on the next

page, you must insert a tab before each number! With the

I-beam (the text cursor: ), click directly to the left of each number (you

have to really click close to the number) to set the insertion point. Press

the Tab key once. Don’t worry about where text aligns yet!  When you set

your own tabs in the ruler, everything will fall into place.

➍➌

➋
➊

➎

☞
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Double, double toil and trouble; fire burn, and cauldron bubble:

1. Fillet of a fenny snake, in the cauldron boil
and bake.

2. Eye of newt and toe of frog.
3. Wool of bat and tongue of dog.
4. Adder’s fork and blind-worm’s sting.
5. Lizard’s leg and owlet’s wing.
6. Scale of dragon, tooth of wolf.
7. Witches’ mummy.
8. Maw and gulf of the ravenous salt-sea shark.
9. Root of hemlock digg’d in the dark.

10. Nose of Turk and Tartar’s lips.
11. Finger of birth-strangled babe, ditch-delivered

by a drab.
12. Cool it with a baboon’s blood.

Then the charm is firm and good, for a charm of powerful trouble,
like a hell-broth boil and bubble.

Exercise 13: continued

You can use this to practice with. After formatting the numbered
paragraphs, click your insertion point after the last word in item #12
(after “blood.”). Hit a return, then make up some more ingredients to
continue the pattern of indented numbers.
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Word and Microsoft Works

❏ If you haven’t done it already, type a tab in front of each number.

❏ Select the numbered paragraphs, 1 through 12.

❏ Hold the Shift key down and drag the bottom half of the triangle (which
is the left indent marker, right?) to the 3⁄8-inch mark on the ruler.

❏ Click on the decimal tab button , then click in the ruler at 1⁄4 inch.

❏ Bring the right indent in to about 3 inches.

MacWrite II, ClarisWorks, WriteNow

❏ If you haven’t done it already, type a tab in front of each number.

❏ Select the numbered paragraphs, 1 through 12.

❏ Hold the Option key down and drag the triangle (which is the left
indent marker, yes?) about 3⁄8-inch to the right. (In WriteNow, you
cannot move the left indent independently; you’ll have to drag both
markers over, then drag the first-line indent marker back to zero.)

❏ Press on the decimal tab button and drag a tab marker to 1.5 inch.

❏ Bring the right indent in to about the 5-inch mark.

PageMaker

❏ If you haven’t done it already, type a tab in front of each number.

❏ With the text tool, select the numbered paragraphs, 1 through 12.
Press Command I to get the ruler.

❏ Hold the Shift key down and drag the bottom half of the triangle
(the left indent marker, right?) to the 3⁄8-inch mark on the ruler.

❏ Click on the decimal tab button , then click in the ruler at 1⁄4 inch.

❏ Click on the left-aligned tab button , then click directly under  the
left indent marker; when you let go, the tab will snap up and land on
the marker. If it is not directly on top of the left indent, drag it into
position (as shown in the ruler on the opposite page).

❏ Bring the right indent in to about 3 inches (scroll if you can’t see the
marker). Click OK.

QuarkXPress

❏ If you haven’t done it already, type a tab in front of each number.

❏ With the Content tool, select the numbered paragraphs, 1 through 12.
Press Command Shift T to get the tabs ruler.

❏ Drag the left triangles to the 3⁄8-inch mark on the ruler, then drag the
top half of the triangle back to zero.

❏ Choose a decimal tab from the Alignment menu, then click in the
ruler at 1⁄4 inch.

❏ Bring the right indent in to about 3 inches. Click OK.

First read page 47, particularly the note at the bottom of the page: you
must insert a tab before each number or the formatting won’t work.
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Exercise 14: Do it yourself
Open, place, or get Exercise 14.

Memorandum

To: You, the reader
From: Me, the teacher

Subject: This very memorandum

So here you are at the end of the exercises. I do hope this made some sense and that you
learned a few things. This particular file is to give you some practice putting your power
to work.

Notice there are no step-by-step directions. And
notice that the file on your screen does not look like
the file in the book. No—that’s your job! Make the
file on your screen match the file in the book.

I know you know how to do this. Do you need a few hints? Do you need a few
guidelines? Do you need me to tell you what to do?

1. Align the two columns of information at the top of the
page (the To/From/Subject information).

2. Set a first-line indent for the appropriate paragraphs.
9. What? Number 9? Did you skip something?

10. Yes. I skipped those numbers on purpose. You really need
to know how to align these periods in a list of numbers.

Rather than repeat the ruler formatting separately for each of these paragraphs that
are similar, can you think of an easier way? If you and your application use style sheets
(which you really should, but that’s another book), you can create and apply a style
sheet. Otherwise, check page 48 for details on how to copy formatting from one
paragraph to another.

If you enjoyed this little book and found it useful, perhaps it might make you think
of other topics that you would like to see in this or in a similar format. If so, please let
me or Peachpit Press know. Here is how to contact Peachpit Press:

• Peachpit Press
2414 Sixth Street
Berkeley, California 94710

• Phone: 800.283.9444
510.548.4393

• Fax: 510.548.5991
Thank you very much. I hope you enjoyed yourself. If you’re ever in Santa Fe on the

first Wednesday of a month, stop in at our user group meeting. I also run a SIG (special
interest group) that is specifically geared to beginners (although we certainly welcome
power users). Until then, remember: your attitude is your life.
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This is a test. This is only a test.

Yes, it’s a pretty ugly memorandum, but that’s not the point today, right? The
point is just to make sure you have control over the tabs and indents. You can
format your memo however you like. Shown on the opposite page is just a
hodge-podge of typical tabs and indent problems.

❏ I typed two tabs before “Memorandum” because I knew I was going
to want to align it with the “You/Me/This” data. This is formatted just
like Exercise #10.

❏ This first paragraph has no tabs or indents. It is justified on this page,
though. Traditionally, the first paragraph does not have an indent
because the purpose of an indent is to tell you another paragraph
has started and if it’s the first paragraph, you already know that.

❏ The second paragraph of body copy is indented both left and right.
I chose to align the left indent on the same alignment as the “You/
Me” information.

❏ The third paragraph does have an indent, using the first-line indent
marker (the one that moves by itself). I know you were taught on a
typewriter to indent paragraphs five spaces or one-half inch, but
good typography indents only one em, which is about two spaces
worth. Specifically, an em is the width of the point size of the type: if
the type size is 12 point, the indent is 12 points. Not all programs let
you specify the point size of your indent, but you can approximate
close enough.

❏ The Peachpit Press information is indented—I did not type a tab
before each bullet! I just moved both the indents (left and first-line).
I typed a tab after  the bullet—those are not spaces after the bullet!
Never use the spacebar to indent, even if it’s just two spaces.
Always tab.        (Type the bullet • by pressing Option 8.)

❏ For the “Phone” and “Fax” lines, I typed a bullet; hit Tab; typed
“Phone:”; hit Tab; typed the number. For the phone number on the
middle line (the 510 number), I hit the Tab key twice to bump the
number over to the tab marker that aligned with the first phone
number.
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Copy the Formatting

Sometimes you want to copy the ruler formatting from one paragraph and

apply it to another. One effective way to do this is to use style sheets, but that’s
another book. If you don’t know how to use style sheets, or if your application
does not have style sheets, or if you want to just copy a format quickly without
bothering to use style sheets, here’s how to do it.

Keep in mind that, in word processors, copying the ruler formatting this way
copies the entire paragraph formatting, which includes alignment, style
sheets, leading, paragraph spacing, and indents, as well as tabs.

Word

Word has a complicated way to copy formats, but the easiest thing to do is copy
the paragraph symbol from one paragraph and paste it into the other paragraph.
In Word, that little paragraph symbol contains all the ruler formatting.

Press Command J so you can see the paragraph
symbols. Select the symbol at the end of the
paragraph whose formatting you wish to copy.
Press Command C to copy it.

[Note: you do not have to have the symbols
visible to do this!]

Select the paragraph symbol at the end of the
paragraph that you wish to apply the formatting
to. Notice the ruler settings in each of
these examples! And notice the paragraph
symbol being selected.

While the paragraph symbol is selected, press
Command V to paste the first symbol, which
replaces the symbol that originally belonged to
this paragraph. Et violà—the second paragraph
has the ruler formatting of the first paragraph.

Microsoft Works

In the Microsoft Works word processor, click in the paragraph whose ruler
formatting you want to copy. From the Document menu, choose “Copy Ruler
Settings,” or  press Command K.

Click in the paragraph you want to apply the ruler setting to, or press-and-drag
to select more than one paragraph. From the Document menu, choose “Paste
Ruler Settings,” or press Command Y.
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MacWrite II and ClarisWorks

In either MacWrite II or in the ClarisWorks word processor, click in the
paragraph whose ruler formatting you want to copy. From the Format menu,
choose “Copy Ruler,” or  press Command Shift C.

Click in the paragraph you want to apply the ruler setting to, or press-and-drag
to select more than one paragraph. From the Format menu, choose “Apply
Ruler,” or  press Command Shift V.

WriteNow

In WriteNow, click in the paragraph whose ruler formatting you want to copy.
From the Custom menu, choose “Copy Ruler,” or press Command 1 (one).

Click in the paragraph you want to apply the ruler setting to, or press-and-drag
to select more than one paragraph. From the Custom menu, choose “Paste
Ruler,” or press Command 2.

PageMaker

Without using style sheets, you can only copy tab and indent settings from one
paragraph into other paragraphs that are directly below and in the same story.
Use the text tool to select the paragraph that contains the tabs and indents you
want to apply to others. Press-and-drag downward to select the other paragraphs
you want to apply the formatting to.

Press Command I to get the ruler. The ruler will display the tabs and indents for
the first paragraph. Just click the OK button, and that ruler setting will be applied
to all the selected paragraphs.

[Sometimes I have copied a paragraph whose formatting I wanted to apply to
others, then pasted it into a story above those other paragraphs. Then I selected
the new paragraph and all the rest of the following paragraphs, applied the style,
then deleted the new paragraph. A klugey technique, but it works.]

QuarkXPress

In QuarkXPress, select the paragraphs to which you want to apply new tabs,
indents, and paragraph formatting. Hold down the Option and Shift keys and
click in the paragraph from which you want to copy the formatting. This copies
all the paragraph formatting. Note: You can only copy formatting from a
paragraph in the same story.

If you want to copy just the tabs and indents, first select the paragraph that holds
the tabs you want. Then press-and-drag to select any following paragraphs to
apply it to. Press Command Shift T to get the Tabs ruler. Click OK. The formatting
from the first paragraph will apply to the others.

(You can also use the kluge [klooj, meaning a dorky technique that happens to
work, albeit inelegantly] mentioned in PageMaker, above.)
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Typing Your Own Text

You can create your own set of tabs and indents in either of two ways:

1. Type the text first. Type tabs where you will eventually want
to align something, but don’t worry now whether it lines up
or not, because it probably won’t! Come in later (“later” meaning
sometime within the next few lines) and set the tabs in the ruler.
With this method, your text won’t be formatted as you type. That’s okay!
Who cares where it is at the moment? You know that when you set the tabs
and indents in the ruler, all those words that have been told to go to tabs
and indents will go there, just like you told them. A good exercise to
experiment with is #6.

2. OR while the insertion point is flashing on a new line, you can
set up tabs first and then begin typing, coming in later to adjust
them if necessary.
If there is an insertion point flashing, but no text selected  when you choose
any text formatting from the menus or from keyboard shortcuts, then that
formatting gets poured into the flashing insertion point. Anything you type
from that point on will hold onto the formatting you chose. That means you
can click to set an insertion point, click in the ruler to set up tabs, perhaps
also set an indent, then start typing. When you hit the Tab key, you know
right where your text will go. You can always adjust it later.

Grand finale: After you have completed this tutorial, if you’re doing fine and
tabs make perfect sense to you, prove it (ha!) by setting up the following chart,
like so (hint: the first line [paragraph] has a different ruler setting than the rest):

Fruit Price Quantity Total

Bananas .18 12 $2.16

Apples .49 6 $2.94

Kiwis .98 22 $22.56

Now if you’re feeling really sassy (ha ha!), add a new column between two
existing columns.

Fruit Date Price Qty. Total

Bananas 1/26/93 .18 12 $2.16

Apples 2/25/93 .49 6 $2.94

Kiwis 3/20/93 .98 22 $22.56
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Suggestions

Here are a few more suggestions for using tabs and indents.

If your application can make custom tabs, use Zapf Dingbats or some other picture
font to create quick lines of graphics. Because this is text, you can color the tab leaders
just as you color your text.

Use a graphic as a hanging indent (paste
it in at the insertion point). Just pretend
the graphic is a number or a bullet, and
arrange the paragraph as in #11.

You may need to select the text and
adjust the leading to make the space
between the lines even.

Different programs do this differently,
and some word processors may not be
able to do it at all.

Name _________________________________

Address _______________________________

City ___________________________________

State/Zip _____________________________

Phone _________________________________

Name ___________________________________________________________________

Address ______________________________________________________________

City ______________________________________________________________________

State/Zip ___________________________________________________________

Phone _________________________________________________________________

Name . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Address . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

City . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

State/Zip . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Phone . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Use tabs with leaders where you want
lines on which to write, or for forms.
The lines will always end at the same
place, unlike those lines you make using
the Shift key and the underline.

In the examples to the right, I have
adjusted the leaders for a more delicate
and sophisticated look. Not all programs
can do this—check the tips and tricks
section on the next page.

Using a graphic instead of a bullet
is a particularly fun option!

▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼

▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼

▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼

▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼▲▼
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Tips and Tricks

All applications

The flashing insertion point always picks up the formatting from the
character to its left—the font, size, style, tabs, indents, etc. So when you
press a Return and take that insertion point to the next line, you take all
the formatting with it. You can take advantage of this by setting the first
paragraph with all the tabs and indents you need, then just press Return
to pull that formatting to the next line as you type.

A quick trick to select all but the last line of text, using almost any
application: Click anywhere, then press Command A. Hold the Shift key
down and click just after the last character you want to select up through.

Or, if your application doesn’t like that, you can always click at the
beginning of the selection, hold the Shift key down, and click at the end of
the selection. Try it!

Microsoft Word

Create an automatic “nested” indent: Select a paragraph(s), then
press Command Shift N (N for Nest). This will indent every line in
the paragraph, just as you see here. The amount of the indent is the
same as the default amount of space between tab stops, which is one-
half inch unless you have consciously changed the default amount.
Each time you press Command Shift N, the paragraph will indent
another half-inch.

Create an automatic hanging indent: Select a paragraph(s), then press
Command Shift T. This will indent every line in the paragraph except
the first line, like this paragraph. The amount of the indent is the same
as the default amount of space between tab stops, which is one-half
inch unless you have consciously changed the default amount.

Remove a “nested” indent: Whether you nested the indent with the
preceding keyboard shortcut or manually, you can press Command Shift M
to shift the indent back one-half inch to the left.

Clear all tab markers from the ruler: Select the paragraph(s). Double-
click on one of the tab markers in the ruler (or press Commant M T) to get
the Tabs dialog box. Click the “Clear All” button. Press Return to close the
Tabs dialog box (you’ll have to press Return twice if you got to the Tabs
dialog box by pressing Command M T).
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Of course, you could use this Tabs dialog box to set your tabs instead
of using the ruler. Type in tab positions, choose the formatting for the tab,
then click the “Set” button and do another one. You can also click in the ruler
while you are in the Tabs dialog box, and the ruler position for that tab you
click will appear in the dialog box.

And you could use the Paragraphs dialog box to set the indents by typing
in values, or you can move the indents in the ruler (yes, while the dialog box
is open) and the ruler measurement will appear in the dialog box.

Open the Tabs dialog box: Double-click on a tab marker in the ruler or
on one of the tab buttons.

Open the Paragraph dialog box: Double-click on an indent marker in
the ruler.

Select just a column of text in which to change the ruler settings: Hold
the Option key as you press-and-drag over the column. It will look like this:

Scroll to the left of the zero mark: Hold down the Shift key and click on
the left scroll arrow at the bottom of the window.

Use a Tab in a table: If you press the Tab key while you are in a table, you
will select the next horizontal cell (press Shift Tab to move to the previous
cell). To actually get to a real tab stop, press Option Tab.

Create custom leaders: Well, you can’t customize them too much, but you
can select the leaders (just press-and-drag over them, one line at a time)
and change the size, style, font, and color. You can change them to some
sort of picture font, such as Zapf Dingbats, and have a limited selection of
images to choose from. Each different leader form you choose (dot, dash,
or underline) will display a different picture character in a picture font.

Microsoft Works

Undo a tab setting: If you immediately decide you don’t want a tab where
you just put one, you can press Command Z to undo the tab stop.
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WriteNow

Create custom leaders: You can use any character you like for a leader in
WriteNow. Then you can select those leader characters and change the font.
For instance, you can press Option 6 for leaders and you will probably see
this character: §. Just select those leaders and change the font to Zapf
Dingbats and your leaders will turn into: ❤ . You can change the size and
color of the characters, also.

QuarkXPress

To create an instant flush-right tab: Instead of pressing the Tab key,
press Option Tab. This will create a tab that will align at the far right indent
and will adjust itself as you adjust the indent of the text box.You can’t set
this particular tab in a style sheet or even in the Tabs ruler—you can only
create it as you type. It’s great for headers or footers or dates.

To remove all tabs from the selected paragraph(s): Hold the Option
key and click in the Tabs ruler.

To scroll to the right edge of the tabs or indents ruler: Click once in the
tab or indent ruler to create a tab marker. Press-and-drag that tab marker to
the right; the ruler will scroll as you go. Then just drag the tab marker off
the bottom of the ruler to remove it. Of course, this will also scroll you back
to the left if you drag to the left.

Switch to Zapf Dingbats for one character to create an interesting
bullet: Press Command Shift Z and the one next character you type will be
in Zapf Dingbats. [You can press Command Shift Q to turn the next character
you type into Symbol.]

Create a quick hanging indent for one paragraph: Click the insertion
point in the paragraph at the position where you want all the following lines
to align (see the example). Press Command \. If you have invisibles turned
on (Command I), the Indent Here character looks like this: .

Can you see the little marker right in front
of “an”? All the other lines in the paragraph
will align at that marker.

This only works in one paragraph at a time; you cannot select more than
one paragraph to do this to, and you cannot put it in a style sheet (use the
indent markers for that). Remove the Indent Here character just as if it were
a letter: click the insertion point to its right, then hit the Delete (Backspace)
key. You can delete the character even if it is invisible.
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Watch the tabs and indents move as you adjust the ruler through the
Paragraph or Tab dialog boxes: Instead of clicking the Apply button
every time you want to see a result, you can hold the Option key down and
click once on Apply. That highlights the button (as shown below) and you
can see the text change dynamically as you click tab markers or change
indents in the ruler.

The Apply button will stay highlighted
until the next time you Option-click on
it, which may be next week.

Customize the tab leaders: In the Tabs dialog box (Command Shift T), you
can position a tab marker and then type any one character of your choice
in the Fill box for a leader. On your publication page, you can select those
tab leaders (just press-and-drag over the leaders) and change the font, the
size, style, tracking, baseline shift, etc. For instance, if you want a line of tiny
hearts, set a tab with leaders and type Option 6 in the Fill box. It will look
like “§” in the box and probably on the page also. So what. Select that line
of §§§ and change the font to Zapf Dingbats.

PageMaker

Create a tab that aligns at the right edge of the text block and will
adjust with that right edge as you resize the text block: Type the
information you want on the left side of the text block, if any. Hit the Tab
key and type the text you want aligned at the right edge. Of course, the text
is not at the right edge yet, but that’s okay. Now press Command Shift R to
give this line a flush right alignment, and the text will move to the right edge.
As you resize the text block, that text will always stay on the right edge.

Create custom leaders: In the tabs/indents ruler you can enter two
characters for a custom leader (choose a tab, click in the ruler to set the tab,
then choose “Custom” from the Leader submenu).

If you want to change the font of the leader, say to Zapf Dingbats, there is a
little trick you can pull. In the ruler, type the keys for the character you want.
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For instance, if you want a row of ➪, type Option Shift S in the Leader edit
box (you might want to type a Spacebar as the second character so there is
a little bit of space between the leaders). You’ll get some weird character in
the box, but so what. Click OK.

In the paragraph, type the text, hit Tab, type the text at the end of the tab.
For this example, the paragraph will look like this:

Type text, hit the Tab key Í Í Í Í Í Í Í Í Í Í Í Í Í Í Í Í Í Í Í Í Í Í Í Í TaDa!

 Now this is the trick: The leaders take on the formatting of the last character
of the text right before the leaders. So insert a “thin space” right before the
leaders: click after the “y” and press Command Shift T (T for thin). Select this
thin space (the easiest way to do so is to hold the Shift key down and press
the left arrow once). While this thin character is selected, change its font to
Zapf Dingbats. You might want to change the size, also, or its color. This is
what the paragraph will look like:

Type text, hit the Tab key ➪ ➪ ➪ ➪ ➪ ➪ ➪ ➪ ➪ ➪ ➪ ➪ ➪ TaDa!

You can use the Story Editor to search and replace this thin character. Search
the selected text for ^t (which will find the tabs) and replace it with ^<^t

(which will replace each tab with a thin space and a tab). Change the
attributes for the thin to the font and size and style of your choice.

(For very thorough directions on using the Story Editor, searching and replacing, and

using tabs and indents, see my PageMaker book, published by Peachpit Press.)



61

Help!

If your tabs aren’t working properly, first check these:

Is the text alignment flush left?

Tabs depend on a flush left alignment or a justified alignment. If you center
the paragraph or align it flush right, your tabs will freak out. Don’t get
confused with centered tabs—do not apply a centered alignment to a line
that uses centered tabs! Sometimes even a justified alignment can throw the
tab alignments off.

Did you select the paragraph(s)?

Remember, the ruler only applies to the paragraphs that are selected, and
a paragraph is selected by virtue of an insertion point flashing within it, or
any numbers of characters within the paragraph being selected. If you have
columns of items, you need to select every line in those columns if you want
to change their tabs or indents.

Did you check the invisible characters?

If your program will show you the invisible characters (see page 13), display
them and see if there are any extra tabs lurking anywhere that may be
throwing the formatting off.

Tabs are affecting more than the selected paragraphs?

A paragraph is defined by a “hard return,” created by pressing the Return
key or sometimes the Enter key. If you change tabs and the ruler seems to
affect more than the selected paragraph, check to make sure you really used
a hard return at the end of the paragraph. If you used a line break (sometimes
called a “soft return”), by pressing Shift Return (or in some programs, Option
Return), then the computer thinks that new text is still part of the same
paragraph and the single ruler setting will apply to it all. Display the non-
printing characters (see page 13) and check for paragraph endings. Insert
Returns where you need them (just click and press Return).

You don’t even see a ruler?

You can always choose to see the ruler or not. If you don’t see it, look
through your menus for the “Show Ruler” or “Bring ruler to Front” command.
It is usually Command R, and Command R will also hide the ruler, if it is
already showing.
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Your solid leader line is dashed?

The most likely cause of this is that you are using a font with a city name.
The dashed line will undoubtedly occur when you use a city-named font and
print to a PostScript printer. Change the text to a non-city-named font. For
instance, if you are using New York, select all and change it to Times or
Palatino.

Also, if you are using an application that lets you select the tab and apply
tracking or change the point size, doing so may cause the underline
characters to separate.

Your ruler doesn’t look like the one in this book?

It wasn’t feasible to show the ruler for every application in every excercise.
Check the examples of the rulers on page 19, and keep in mind that even
though your ruler may look different, it acts just the same. Read the
directions. And read the information at the beginning of the book, “Things
You Should Know.” Read it again whenever you get confused.

You selected more than one paragraph, and now the ruler is
gray or you don’t see the tab markers you were expecting?

Just as in your type menus, when you select text that holds more than one
of any kind of formatting (such as more than one font or more than one
indent), the ruler or menu cannot show you all the different formatting for
the different characters or paragraphs. Some show you nothing (like no
checkmark at all in the menu) which is a visual clue that there is more than
one formatting selected. Some display the ruler as gray, which is a visual clue
that there is more than one formatting selected. Some display the formatting
for the first character or the first paragraph in the selection. Usually (but not
in every application) if you select text and apply new formatting, it will
override all existing formatting. If you have several paragraphs selected that
have several different tabs and indents set, and the ruler displays just the
formatting for the first paragraph, then when you make any slight change
in the ruler (or click the OK button in a dialog box), the formatting from the
first paragraph will apply to all the selected ones.

So the point is, no ruler marks or a gray ruler tells you that the different parts
of text you have selected have inconsistent formatting. With the I-beam,
click just once in any paragraph and you will see the ruler formatting for just
that one paragraph. Experiment and check your application’s manual to see
exactly how your ruler deals with displaying multiple formatting.
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Some tab leaders are bold, some are light—how do you
make them consistent?

Do you have a problem like this: And you want it to look like this:

In most applications you can customize the leaders as easily as selecting
them and changing their font, size, and style (just press-and-drag over the
leaders). Check the previous section on Tips and Tricks for further tips on
customizing  the leaders and specific directions in various applications.

In Microsoft Word, you cannot see the indents or tabs, and
nothing happens when you click in the ruler?

The “indent scale” button has probably been deselected. Look on the left
side of the ruler, above the measurements. Do you see this:  ?

Well, click in the little picture on the left so it looks like this: . All your
ruler indents, tabs, and alignment options will return.

In Microsoft Works, the tabs keep changing their alignment?

In Microsoft Works, you can change from a left-aligned tab to a centered tab
to a right-aligned tab to a decimal tab simply by clicking on the tab marker
in the ruler. For instance, if you have a left-aligned tab set in the ruler and
you click on that tab marker, the left-aligned tab will turn into a centered
tab. Each time you click, it cycles to the next sort of tab. Watch those tails
carefully—keep an eye on the direction of the tail, which indicates the
direction of the type.

Act I ....................... 17
Scene 1 ............. 17
Scene 2 ............. 23

Act II ...................... 30

Act I .................. 17
Scene 1 ........... 17
Scene 2 ........... 23

Act II ................. 30
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Colophon

I produced this little book in PageMaker, using

the fonts Antique Olive and ITC Garamond, both

from Linotype-Hell.

If you really wanna know

I live very happily in Santa Fe, New Mexico,
with my three kids. I write for a number of
magazines, I teach at various places, I do a lot
of public speaking, I run a user group, I take
as many dance classes as I can, I’m learning
to drum, and I believe in the adage that “luck
is where preparation meets opportunity.”
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